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Exam A

QUESTION 1
Which of the following network devices interconnects workstations and broadcasts the data that is being
transmitted?

A. Switch
B. Modem
C. Router
D. Hub

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 2
Which of the following should the technician have the ability to check properties of a user's pagefile in Windows
XP?

A. Windows Explorer>Tools>Folder Options>View tab>Select 'Show hidden files and folders'
B. Windows Explorer>Tools>Folder Options>View tab>Uncheck 'Hide extensions for known file system types'
C. Windows Explorer>Tools>Folder Options>View tab>Check 'Display the contents of system folders'
D. Windows Explorer>Tools>Folder Options>View tab>Uncheck 'Hide protected operating system files'

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 3
When determining a customer's specific issue, which of the following is the BEST approach?

A. Ask the customer to speak with someone else that may be able to help.
B. Ask open-ended questions to narrow the scope of the problem,
C. Ask the co-worker what the customer is trying to explain.
D. Ask focused questions that lead the customer with yes or no answers.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 4
Which of the following network devices interconnect networks together?

A. Switch
B. Hub
C. Router



D. Modem

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 5
A technician has implemented a solutiion to resolve a customer's issue with frequent unexpected system
restarts.  Which of the following should be the technician's NEXT troubleshooting step?

A. Verify full system functionality and, if applicable, implement precentative measures.
B. Establish a theory of probable cause based on precious test and determine the next steps to resolve.
C. Document the issue  and include details regarding findings. actions taken to resolve and the outcome.
D. Test the theory to determine if the solution  will rely correct  the issue , list other probably causes.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 6
A techhincian troubleshooting an issue has implemented a solution. Which of the following is the NEXT
troubleshooting step the technician should take?
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A. Test the theory and validate the plan.
B. Ask the customer to describe the symptoms and identify any changes made to the computer.
C. Document findings, actions and outcomes.
D. Verify and implement preventative measures.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 7
Which of the following is the MOST common way to cool a CPU?

A. Water cooling 
B. Heat sink
C. Case fan



D. Air conditiioning

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 8
Thermal compund is designed to do which of the following?

A. Insulate a component from the friction of the heat sink
B. Reduce heat on a component through evaporation
C. Provide for heat transfer from a component to the heatsink
D. Quiet any vibration to a heatsink from a fan

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 9
Which of the following Windows utilities will identify issues with drivers and programs running under Windows
XP?

A. System Information
B. Hardware Compatability List
C. Dr. Watson
D. Program Compatability Wizard

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 10
A user wants their computer to automatically recieve updates from Microsoft; however, they do not want the
updates to interfere while they are working. Which of the following should be selected to BEST meet the user's
needs?

A. Set automatic updates to download only.
B. Turn on Automatic Updates.
C. Turn of the firewall.
D. Set automatic updates to download and install.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:



QUESTION 11
A laptop has just had the LCD replaced and now it is having problems connecting to the wireless network.
Which of the following is the MOST likely reason for the connection issue?

A. The user has removed the antenna.
B. The wireless switch is not on.
C. The LCD is faulty.
D. The network card drivers are corrupt.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 12
Which of the following would be the BEST resolution setting for an application that requires a minimum
resolution of 1024x768?

A. SVGA
B. PAL
C. VGA
D. XGA

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 13
A user running Windows XP reports that their computer has not been printing  any subsequent documents
since the printer jam occured earlier that day. The printer is now working normally for other users. Before
rebooting the computer, which of the following is the FIRST step the technician should take?

A. Remove and re-add the printer.
B. Restart the print spooler service.
C. Reset the maintenance page count on the printer.
D. Attempt to print the test page.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 14
Which of the following protocols are commonly used for Windows Remote Desktop?

A. NTP
B. PPTP



C. RDP
D. LDAP

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 15
A technician is called to a school lab to fix a computer. The computer worked fine the day before, but now does
not power on. The computer is plugged into a power strip with another computer. The other computer works
fine. Whic of the following could be the problem? (Select TWO).

A. The power strip is overloaded.
B. The monitor is unplugged.
C. The power cable is unplugged from the computer.
D. The power strip is unplugged.
E. The voltage switch on the computer is set incorrectly.

Correct Answer: AE
Section: (none)
Explanation

Explanation/Reference:

QUESTION 16
Which of the following is a characteristic of plenum-rated cable?

A. Recommended for analog phone lines
B. Flexible PVC outer jacket
C. Recommended for ceiling use only
D. Recommended for use in HVAC

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 17
Which of the following IP ranges is Class C?

A. 192.0.0.0 - 255.255.255.255
B. 128.0.0.0 - 191.255.255.255
C. 1.1.1.1. - 126.255.255.255
D. 224.0.0.0 - 255.255.255.255

Correct Answer: A
Section: (none)
Explanation



Explanation/Reference:

QUESTION 18
Which of the following is the maximum FAT32 volume size Windows 2000 and XP will recognize?

A. Up to 16 GB
B. Up to 32 GB
C. Up to 1024 GB
D. Up to 2048 GB

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 19
Which of the following voltages does the ATX power supply provide? (Select TWO).

A. 3.3v
B. 5v
C. -5v
D. 15v
E. -15v

Correct Answer: AB
Section: (none)
Explanation

Explanation/Reference:

QUESTION 20
In order for the print spooler service to start or run correctly, the print spooler requires other services to be
running first. These types of services are known as:

A. primary services
B. registry level services
C. dependency services
D. driver level services

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 21
Which of the following would be the MOST secure on a wireless router for a SOHO?

A. WEP
B. SSID disabled



C. MAC Filtering
D. WPA

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 22
Which of the following cable types is the MOST common Ethernet cable?

A. Fiber
B. CAT3
C. UTP
D. Coaxial

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 23
Smart cards are an example of:

A. who you are.
B. what you have.
C. what you do.
D. what you know.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 24
Which of the following wireless technology standards can operate at either 2.4 GHz or 5GHz frequencies?

A. 802.11a
B. 802.11b
C. 802.11g
D. 802.11n

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:



QUESTION 25
Which of the following adapter cards would be the FASTEST for connecting an external hard drive?

A. Wide SCSI
B. FireWire 800
C. eSATA
D. USB 2.0

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 26
Which of the following devices is used to move frames between a source and destination based on a MAC
address?

A. Repeater
B. Hub
C. Router
D. Switch

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 27
A laser printer has an error 'tray two paper jam', but tray two does not have any paper in it. Which of the
following should the technician do FIRST?

A. Replace the tray two paper sensor and run the printer self test.
B. Remove the tray two paper sensor and clean the print head.
C. Check the tray two paper sensors for blockage and run the printer self test.
D. Check the tray two paper rollers for the blockage, clean the printhead, and run the printer self test.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 28
A dry cleaner is having issues with their computer overheating. Which of the following preventive maintenance
techniques would be the BEST short-term resolution to the problem?

A. Update the firmware on the machine to accommodate for higher temperatures.
B. Use Disk Cleanup and Defrag to keep the machine from working as hard.
C. Use a can of compressed air to clean out blocked ventilation.
D. Relocate the machine to a cooler part of the building.



Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 29
Which of the following is typically connected to a PCMCIA adapter?

A. Sound card
B. Biometric scanner
C. Portable FM Transmitter
D. External video card

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 30
A technician encounters an IP address of 126.22.240.1. The IP address is a member of which of the following
classes?

A. Class A
B. Class B
C. Class C
D. Class D

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 31
Which of the following BEST describes how long data should be stored on a computer?

A. Follow local legal requirements
B. Delete after use
C. Save data for one year
D. Save data for five years

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 32
A four color inkjet printer is experiencing color washout (e.g. - not clear or not bright) when printing



photographs. The user states that no software or hardware changes have been performed . Which of the
following is the FIRST step to take in resolving this issue?

A. Run the clean/align print head procedure.
B. Remove the print heads and clean them with a soft cloth.
C. Replace the print heads and run the printer color calibration procedure.
D. Update the application software.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 33
Which of the following requires a specific password to be typed manually for connection?

A. MAC filtering
B. Smart card
C. Biometrics
D. WEP

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 34
A technician is servicing a customer's color printer and notices excess toner in the printer. Which of the
following tools would BEST assist the technician in removing the excess toner?

A. Damp towel
B. Compressed air
C. Alcohol wipe
D. Computer vacuum

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 35
EEE1394b is capable of transfer rates up to:

A. 12 Mbps
B. 400 Mbps
C. 480 Mbps
D. 800 Mbps

Correct Answer: D



Section: (none)
Explanation

Explanation/Reference:

QUESTION 36
Which of the following is a power supply that has one single plug and socket?

A. Heat sink
B. AT
C. ATX
D. UPS

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 37
A networking device that keeps track of which computer or device is connected to each port is a:

A. gateway
B. switch
C. hub
D. VLAN

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 38
The PING command can be used to determine which of the following? (Select TWO).

A. If there is a connection to a specified IP address
B. The gateway address of a currently logged on user
C. The response time of the connection to a specific IP address
D. The amount of hops it takes to reach a destination computer
E. The active connections to a computer

Correct Answer: AC
Section: (none)
Explanation

Explanation/Reference:

QUESTION 39
A user reports that a laptop is too hot to use in their lap. Which of the following should the technician check
FIRST? (Select TWO).



A. HDD
B. Fan
C. Heat sink
D. Processor
E. Battery

Correct Answer: BC
Section: (none)
Explanation

Explanation/Reference:

QUESTION 40
Which of the following is the system bus speed of a stick of PC2700 memory?

A. 133 MHz
B. 166 MHz
C. 266 MHz
D. 333 Mhz

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 41
Which of the following BEST describes L2 cache?

A. The largest cache that resides outside the chip level
B. The fastest cache that resides outside the chip level
C. The largest cache that resides at the chip level
D. The fastest cache that resides at the chip level

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 42
When working within large computer networks, which of the following is the disadvantage of using NEETBEUI
over TCP/IP? (Select TWO).

A. NETBEUI is designed to be used on small sized LANs.
B. NETBEUI is unavailible on non-Windows operating systems.
C. NETBEUI can only be used on pre-Windows NT networks.
D. NETBEUI is not a mutable protocol.
E. NETBEUI can only be used with DHCP.

Correct Answer: AD



Section: (none)
Explanation

Explanation/Reference:

QUESTION 43
Which of the following voltages is MOST commonly associated with DIMMs?

A. +3.3v
B. +5v
C. -12v
D. +12v

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 44
Which of the following Internet connections has the highest latency?

A. Cable
B. Satellite
C. DSL
D. Dial-up

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 45
Which of the following attributes is set when a file is ready to be backed up?

A. a
B. h
C. r
D. s

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 46
Which of the following is an example of a Class D IP address?

A. 192.0.0.0



B. 127.255.255.255
C. 255.255.255.255
D. 224.0.0.0

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 47
Which of the following IP ranges is Class B?

A. 128.0.0.0 - 191.255.255.255
B. 192.0.0.0 - 223.255.255.255
C. 224.0.0.0 - 255.255.255.0
D. 1.1.1.1 - 126.255.255.255

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 48
A customer has asked a technician when completion of the work is expected. Which of the following is the
BEST approach in answering their question?

A. Tell the customer that the work will be completed as soon as possible.
B. Tell the customer that since the work is quite detailed and it is unsure , but will let them know.
C. Tell the customeran estimated time and make sure both parties understand and agree.
D. Tell the customer that due to the volume of work it would be best not to give a specific time.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 49
Which of the following needs to be configured on a Windows Vista machine to allow for ports 21 and 25 to
function properly?

A. Anti-spyware protector
B. Firewall
C. UAC
D. Antivirus protection

Correct Answer: B
Section: (none)
Explanation



Explanation/Reference:

QUESTION 50
A technican downloads an updated version of the driver for a sound card in Windows XP. After extracting the
driver, how would the technician update the driver?

A. Device Manager> expand 'Sound, video and game controllers'>double click on the name of the sound card>
Troubleshoot'

B. Start> Control Panel > Administrative Tools > Update Drivers > double click on 'Sound Card'
C. Start > Control Panel > Administrative Tools > Sound Devices > 'Update Driver'
D. Device Manager > Driver tab > Update Driver > Double click on the name of the sound card under 'Sound,

video and game controllers'

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
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QUESTION 51
Which of the following are the output voltages of an ATX power supply? (Select TWO).

A. 5v
B. 9v
C. 12v
D. 15v
E. 24v

Correct Answer: AC
Section: (none)
Explanation

Explanation/Reference:

QUESTION 52
The user has forgotten their password. Which of the following would be the Best option for reconfiguring their
password?

A. Safe Mode
B. OS Reinstall
C. Emergency Repair Disk
D. Recovery Console

Correct Answer: C
Section: (none)



Explanation

Explanation/Reference:

QUESTION 53
Which of the following ports does Windows firewall open by default for Remote Desktop to work?

A. 25
B. 80
C. 3389
D. 8080

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 54
In the past there has been a series of thefts including laptops with personal information on them. Which of the
following is the BEST way to protect the personal information and prevent unauthorized access to the
information in the event that a laptop is stolen?

A. Power on password
B. Intrusion detection
C. Complex logon passwords
D. Drive Lock

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 55
A Windows XP workgroup computer can have up to how many concurrent connections?

A. 10 or fewer
B. 15 or fewer
C. 20 or fewer
D. 25 or fewer

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 56
Which of the following is the MINIMUM amount of memory required to install Windows XP Professional?

A. 64 MB



B. 128 MB
C. 256 MB
D. 512 MB

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 57
The customer calls a technician and informs them that their keyboard was cleaned with a solution, and now
their fingers sting. Where would the technician or medical personnel find information about the substance on
the keyboard?

A. The MSDS
B. The local fire department
C. The Standard Operating Procedures manual
D. The facilities department of the company

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 58
Which of the following ports need to be turned off on a firewall to block Telnet?

A. 21
B. 23
C. 25
D. 80

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 59
How many volts does an internal floppy drive use?

A. 3.3
B. 5
C. 12
D. 14

Correct Answer: C
Section: (none)
Explanation



Explanation/Reference:

QUESTION 60
Which of the following BEST describes the North Bridge change that occurred with the introduction of AMD
Athlon 64?

A. Upstream communication to the North Bridge was enhanced.
B. Multiple pipelines were provided doubling the bus rate.
C. Downstream communication to the North Bridge was enhanced.
D. The memory controller is onboard the processor chip.

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 61
Which of the following wireless technology standards can operate at a MAXIMUM of 54 Mbps? (Select TWO).

A. 802.11a
B. 802.11b
C. 802.11g
D. 802.11k
E. 802.11n

Correct Answer: AC
Section: (none)
Explanation

Explanation/Reference:

QUESTION 62
A user can no longer launch their word processing program. The program worked fine yesterday. Which of the
following options could BEST be used to fix the word processing program?

A. Safe Mode
B. Automated System Recovery
C. Last Known Good Configuration
D. System Restore

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 63
Which of the following printer types would MOST likely be used in a shipping department to create shipping
labels on adhesive paper?



A. Inkjet
B. Laser
C. Thermal
D. Impact

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 64
In regards to computer case form factors, which of the following provides the MOST room for effective cooling?

A. BTX
B. ATX
C. NLX
D. Micro ATX

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 65
The user boots their computer in the morning to discover the message 'OS not found'. Which of the following
would recover fromt that error without data loss?

A. Insert the system boot disk and repair the operating system.
B. Install a new hard drive and restore the system.
C. Restore the BIOS configuration to default to recognize the drive.
D. Use the manufacturer's supplied system recovery dsk and restore the system.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 66
Which of the following IP ranges is Class E?

A. 240.0.0.0 - 254.255.255.255
B. 128.0.0.0 - 191.255.255.255
C. 1.1.1.1 - 126.255.255.255
D. 192.0.0.0 - 223.255.255.255

Correct Answer: A
Section: (none)
Explanation



Explanation/Reference:

QUESTION 67
Which of the following wireless networking standards uses a 5GHz frequency?

A. 802.11n
B. 802.11g
C. 802.11a
D. 802.11b

Correct Answer: 
Section: (none)
Explanation

Explanation/Reference:

QUESTION 68
Which of the following advanced boot menu options would a technician use to repair the MBR?

A. Safe Mode with Networking
B. Debug Mode
C. Recovery Console
D. Safe Mode

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 69
A wireless network broadcasted from a SOHO WiFi single band router can have a maximum of how many
SSIDs associated with it?

A. One
B. Two
C. Four
D. Five

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 70
A technician replaces a defective bar code reader with a new bar code reader that is the same model. The
operating system recognizes the new reader, but the reader will nto scan any items. The technician connects a
known good scanner to the system  and that scanner works properly. Which of the following is the MOST likely
problem?

A. The driver software needs to be updated.



B. The new scanner needs to be programmed.
C. The new scanner has a bad cable.
D. The software is still looking for the defective scanner.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 71
Which of the following wireless technololgy standards has the SHORTEST indoor range?

A. 802.11a
B. 802.11b
C. 802.11g
D. 802.11n

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 72
Which of the following is a hot plug device for a laptop? (Select TWO).

A. SDRAM
B. Express Card
C. Mini-PCI card
D. PCMCIA card
E. Video card

Correct Answer: CD
Section: (none)
Explanation

Explanation/Reference:

QUESTION 73
The FASTEST cache in a computer is:

A. L1
B. L2
C. L3
D. L4

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:



QUESTION 74
Advanced Power Management (APM) has a number of power states. How many states does APM have?

A. 3
B. 4
C. 5
D. 6

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 75
The technican is repairing a PC which appears to have a failing RAM module. After replacing the module, the
extra memory still is not registering. Which of the following is MOST likely the issue?

A. Jumper settings are incorrect
B. The RAM module is defective
C. The memory slot is defective
D. CMOS needs to be flashed

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 76
Programs that run when the Windows OS starts are stored in which of the following registry hives?

A. HKEY_LOCAL_MACHINE
B. HKEY_CURRENT_CONFIG
C. HKEY_CLASSES
D. HKEY_USERS

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 77
USing the Microsoft Management Console (MMC) in Windows XP Professional, which of the following forces a
user to change their password at the next login?

A. User dialog box
B. Domain policy folder
C. General tab



D. Share folder

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 78
On a motherboard, which of the following is often covered by a heatsink? (Select TWO).

A. GPU
B. CMOS
C. BIOS
D. Front Side Bus
E. North Bridge

Correct Answer: AE
Section: (none)
Explanation

Explanation/Reference:

QUESTION 79
Which of the following processors are capable of running a 64-bit operating system? (Select THREE).

A. Turion
B. Xeon
C. Itanium
D. Pentium Pro
E. Sempron
F. Pentium M

Correct Answer: ABC
Section: (none)
Explanation

Explanation/Reference:

QUESTION 80
APIPA addressing uses which of the following network classes?

A. A
B. B
C. C
D. D

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:



QUESTION 81
Which of the following network cable types is MOST often used in environments where physical security of the
data  is the top priority?

A. UTP
B. Coaxial
C. Fiber Optic
D. STP

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:



Exam B

QUESTION 1
Which of the following memory types has a clock speed of 500 MHz?

A. PC133
B. PC2700
C. PC3200
D. PC10600

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 2
Which of the following DSL types has the same upstream and downstream bandwidth>

A. IDSL
B. FIOS
C. ADSL
D. SDSL

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 3
A PC will not power on. The technician has verified there is power coming from the outlet and the indicator on
the back of the power supply is blinking green. Which of the following is the cause of the problem?

A. Power suply has a bad motherboard connector.
B. Power supply is not powerful enough.
C. Power supply is running at half power.
D. Power supply is only producing DC current.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 4
Which of the following locations will allow a user to change the Windows Vista Start Menu to resemble the
Windows XP Start Menu?

A. Right-click Start Menu/Prperties/Start Meu tab
B. Control Panel/User Accounts
C. Start/All Programs/Accessories/Ease of Access



D. Right-click Desktop/Personalize

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 5
Which of the following voltages can be found in the output of a functioning ATX power supply?

A. 9v
B. 12v
C. 15v
D. 24v

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 6
Which of the following utilities can an administrator use to manange hardware, software and network
components?

A. Device Manager
B. MMC
C. msinfo32
D. msconfig

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 7
Which of the following explains a yellow exclamation point next to a device in the Device Manager?

A. A driver was installed but not digitally signed.
B. A usable driver could not be installed for this device.
C. The device is operable, but not at full capacity.
D. The device is built-in and not upgradeable.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 8



A technician needs to test connectivity to a particular host. Which of the following commands would MOST
likely be used?

A. telnet
B. netstat
C. ipconfig
D. ping

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 9
A user reports that print jobs sent to a local printer are printing out as blank pieces of paper. Which of the
following steps should the technician perform FIRST on the printer to determine the cause?

A. Stop and restart the print spooler
B. Reload the printer drivers
C. Print an internal test page
D. Replace the printer cable

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 10
A laptop needs a new card reader installed in order to provide the ability to access CF and SD media. Which of
the following ports, found on laptops, would be used to install the upgrade?

A. DVIport
B. Parallel port
C. Mini-PCI port
D. PCMCIA port

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 11
A technician encounters an IP address of 191.15.20.1. The IP address is a member of which of the following
classes?

A. Class A
B. Class B
C. Class C
D. Class D



Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 12
Which of the following RAID arrays does only striped volumes?

A. RAID 0
B. RAID 1
C. RAID 5
D. RAID 10

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
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QUESTION 13
A technican dropped a screw on the case of a desktop computer. Which of the following tools should be used
to retreive the screws?

A. Computer vacuum
B. Plastic tweezers
C. Canned air
D. Screwdriver with magnetized tip

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 14
Which of the following is an example of a Class C IP address?

A. 127.0.0.1
B. 192.168.1.100
C. 255.255.255.0
D. 225.225.225.1

Correct Answer: B



Section: (none)
Explanation

Explanation/Reference:

QUESTION 15
In order for a custmer to feel more comfortable with a repair, a technician should always do which of the
following before proceeding?

A. Offer the customer a new machine.
B. Offer repair/replacement options.
C. Avoid being late.
D. Avoid being judgemental.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 16
Which of the following memory types needs to be refreshed?

A. Non-parity
B. Parity
C. DRAM
D. SRAM

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 17
Which of the following would be used to monitor unauthorized access to data files?

A. Performance Log and Alerts
B. Event Viewer
C. Security Configuration
D. IP Security Monitor

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 18
Multiple users report that the network color printer is not printing in color, but only in monochrome. The
technician knows the print server had maintenance done over the weekend that incuded driver updates. The
NEXT action would be toL



A. flash the firmware on the printer to match the new driver.
B. check the printer properties on the server.
C. power cycle the printer to update the driver.
D. have each user remove and re-install the printer to update the driver.

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 19
A customer reports that while attempting to print a document it seems to queue up fine , but the printer does not
print the job. Which of the following may be the cause?

A. Outdated or corrupt print driver.
B. The application used to create the document is incompatible with the printer.
C. A print job is waiting in the print queue.
D. Printer configuration is incorrect.

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 20
An unidentified person gains access to an office workplace, posing as a new IT staff member. The unidentified
person tries to obtain passwords through conversation with other administrators. Which of the following security
breaches is occurring?

A. Social engineering
B. Brute force cracking
C. Biometric attack
D. Phishing

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 21
Which of the following IP addresses is a Class B address?

A. 92.25.16.128
B. 192.168.1.1
C. 201.29.253.9
D. 129.254.18.10

Correct Answer: D



Section: (none)
Explanation

Explanation/Reference:

QUESTION 22
Which of the following are some of the performance requirements for Windows Vista Aero? (Select TWO).

A. 1 GB of system RAM
B. 1 GHz CPU
C. 64 MB Video Adapter
D. 500 GB Hard Drive
E. LCD Monitor

Correct Answer: AB
Section: (none)
Explanation

Explanation/Reference:

QUESTION 23
Which of the following tools uses trusted platform module (TPM) to enable the service?

A. Windows BitLocker
B. Windows EFS
C. Windows Defender
D. Windows Security Center

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 24
Which of the following is required when printing to an LPR port?

A. MAC address
B. IP address
C. Printer name
D. Server name
E. Net Mask

Correct Answer: BC
Section: (none)
Explanation

Explanation/Reference:

QUESTION 25
Which of the following WLAN protocols is in the 5GHz band with a MAXIMUM data rate of 54Mbps?



A. 802.11a
B. 802.11b
C. 802.11g
D. 802.11n

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 26
Which of the following processors uses a pin array cartridge?

A. Athlon XP
B. Itanium
C. Xeon
D. Pentium IV

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 27
Which of the following should be FIRST in the BIOS boot order to be able to enter into the Recovery Console
off the installation disk?

A. Optical drive
B. Hard drive
C. Floppy Disk
D. Network

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

QUESTION 28
A user would like to backup their data weekly. Which of the following should a technician MOST likely
recommend?

A. DVD
B. USB SSD
C. CD
D. Blu-Ray

Correct Answer: B
Section: (none)



Explanation

Explanation/Reference:

QUESTION 29
Which of the following methods can be used to apply a file system to a hard drive partition? (Select TWO).

A. Device Manager MMC
B. Format Command
C. Disk Management MMC
D. Windows Explorer Menus
E. FDISK Command

Correct Answer: BC
Section: (none)
Explanation

Explanation/Reference:

QUESTION 30
Which of the following is the MAXIMUM supported amount of RAM for Windows XP Home?

A. 1024 MB
B. 2 GB
C. 32 GB
D. 4 GB

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 31
Which of the following is required to support BitLocker drive encryption with default settings? (Select TWO).

A. More that 2GB of availible free space
B. Two partitions
C. Windows Vista Business Edition
D. All drives must be converted to Dynamic Disks
E. Trusted Platform Module (TPM)

Correct Answer: BE
Section: (none)
Explanation

Explanation/Reference:

QUESTION 32
Which of the following BEST describes a virus?



A. Malicious code that can propogate itself to different host files.
B. A malicious program that spreads itself in a system without the need of a host
C. A program that is used to track user information for commercial reasons.
D. A program that appears to be harmless but has a malicious agenda.

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:

QUESTION 33
Which of the following is the BEST way to secure wireless traffic to an access point?

A. Use 802.11g
B. WPA
C. WEP
D. SSID broadcast disable

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 34
Which of the following allows for the GREATEST heat dissipation?

A. Liquid Cooling
B. Case Fans
C. Heatsink
D. Thermal Compund

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 35
Which of the following steps in the troubleshooting process should be performed when the cause cannot be
confirmed?

A. Establish a plan of action
B. Document findings
C. Re-establish new theory
D. Identify the problem

Correct Answer: B
Section: (none)
Explanation



Explanation/Reference:

QUESTION 36
Which of the following memory modules has 72 pins? (Select TWO)

A. SIMM
B. DIMM
C. RIMM
D. SODIMM
E. RAMBUS

Correct Answer: AD
Section: (none)
Explanation

Explanation/Reference:

QUESTION 37
How can a print spooler help a technician diagnose a problem?

A. Provides a log file of all the printer errors
B. Updates printer firmware via Telnet
C. Shows submitted print jobs
D. Shows all print jobs that were successfully printed

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:

QUESTION 38
Which of the following should be checked prior to an operating system being installed?

A. HDD
B. USB
C. RAM
D. HCL

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:

QUESTION 39
Which of the following IP ranges is Class C?

A. 192.0.0.0 - 223.255.255.255
B. 128.0.0.0 - 191.255.255.255
C. 1.1.1.1 - 126.255.255.255



D. 224.0.0.0 - 255.255.255.0

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
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